CHAPTER 7: PATIENT AREA

Patients belonging to this client are listed alphabetically as name tabs at the bottom of the CID. These tabs will be displayed with a font color which matches the information appropriate for the patient. For example; a deceased patient name tab will be de-highlighted, patients due for reminders are displayed in red, and patients having transactions that are not yet posted to the client’s account are displayed in blue.

In this chapter, you will learn how to:

“Choose Different Patients belonging to the Client” on page 2
“Add/Change Patient(s) Information” on page 2
“Vaccination Reminder History” on page 7
“Print a Patient Chart” on page 8
“Display Patient ID Number” on page 8
“Work with the Reminders Folder” on page 8
“Set up a Patient Follow-up” on page 11
“Specify a Patient Estimate” on page 11
“Set-up Ownership/Split Billing” on page 12
“Work with the Schedule Folder” on page 13
“Add Patient Notes” on page 15
“Delete a Patient” on page 15
“Undelete a Patient” on page 15
“Move a Patient to Another Owner” on page 15
“Access Patient Lab Information” on page 15
“Print Patient ID Collar” on page 15
“View Patient Problem History” on page 16
“Print a Document for the Selected Patient” on page 15
“Enter a Patient Alert” on page 17
“Add File Attachments” on page 18
“Add Invoice Instructions” on page 20
“View Patient Photo and Photo Album” on page 20
“Print Patient Labels” on page 20
“Define a Patient Work List” on page 20
“Export/Import Patients” on page 24
“Use an E-Travel Sheet” on page 24
Choose Different Patients belonging to the Client

AVImark allows you to quickly move from one patient to another belonging to this client.

- Click the name tab of the patient you wish to work with from the bottom of the CID.

Add/Change Patient(s) Information

- In the patient area, right-click and from the shortcut menu click New to display the New Patient Information window.
- Enter the information about the new patient. When all information has been entered, click Done.
Patient name
This field is the patient’s name.

- Type the patient’s name.

Species
This field displays the species of the patient.

- Using the drop down menu, select the species.

Breed
AVImark gives you several options for entering the patient’s breed. You may type a few letters of the breed and AVImark will display a list of those breeds containing those letters and then choose the desired breed. Or you can click on the drop down list to display the breed list in its entirety and choose the appropriate breed.

Because of possible misspellings of breed names when typing them into the Breed field, AVImark has incorporated an “Allow Auto-Add” feature. With this feature non-active, a user, when typing the breed name, must spell the name correctly and it must be in the Breed Table to allow them to continue with adding the new patient. Activated, a user may type the breed name and if misspelled and/or the breed name was not found in the Breed Table, the user will have the option of adding it to the table. For more information on the “Allow Auto-Add” feature, refer to “Error! Reference source not found.”.

- Using one of the methods as discussed above, select the breed type for this patient.
Chapter 7: Patient Area

Color
Entering the color designation can be performed using the same procedures as the breed.

- Enter a color for the patient.

Mix
This field allows you to indicate that the breed is mixed.

- Select this box when the patient is of mixed breed.

Age
When the patient’s birth date is entered, the age will be set automatically. Entering the patient age will change the birth date appropriately, as will the birthday when you enter an age of the patient. Enter the age in days, (e.g. 23d), weeks (e.g. 13w), months (e.g. 8m), or years (e.g. 11 or 11y).

Sex
The background of the patient area will appear pink or blue to represent the sex of the patient. The following table lists each sexual status code and its meaning.

- Click in the Sex field to display the drop down list of patient sex codes.
- Select the appropriate sex code for this patient.

<table>
<thead>
<tr>
<th>Code</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>F</td>
<td>Unaltered female</td>
</tr>
<tr>
<td>M</td>
<td>Unaltered male</td>
</tr>
<tr>
<td>M (Equine)</td>
<td>Mare</td>
</tr>
<tr>
<td>S</td>
<td>Altered female</td>
</tr>
<tr>
<td>S (Equine)</td>
<td>Stallion</td>
</tr>
<tr>
<td>N</td>
<td>Altered male</td>
</tr>
<tr>
<td>G (Equine)</td>
<td>Gelding</td>
</tr>
</tbody>
</table>

Birthday
- Using the drop down calendar, enter the birth date. You may also type the patient’s birthday. Ensure to use slashes between the month and year.
Unknown
This check box is used when you need to enter an approximate birth date of the patient. This will let AVImark know the patient’s age is an estimated date.

- If appropriate, select this box to indicate an approximate birth date.

Weight
This field displays the patient’s weight and unit of measure.

- Type the weight of the patient. Tab to the next field to enter the unit of measure.

Codes
Patient codes identify a certain status about the patient. You may specify up to 5 codes for a patient.

- Click in the Codes field to display the drop down list of Patient codes.
- Select the patient code(s) appropriate for this patient. The following is a list of the Patient Code and their meaning.

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>D</td>
<td>Deceased</td>
<td>Patient is currently deceased.</td>
</tr>
<tr>
<td>H</td>
<td>Hold Reminders</td>
<td>Suppresses printing reminders for this patient only.</td>
</tr>
<tr>
<td>I</td>
<td>Inactive Patient</td>
<td>Patient is currently inactive. This will also suppress the reminders for this patient.</td>
</tr>
<tr>
<td>E</td>
<td>Tax Exempt</td>
<td>Causes this patient to be tax exempt.</td>
</tr>
<tr>
<td>M</td>
<td>Moved or Missing</td>
<td>Indicates patient is moved or missing. This will suppress the reminders for this patient.</td>
</tr>
<tr>
<td>P</td>
<td>OTC Patient</td>
<td>Added to the patients under the Over-the-Counter client. It Voids the 30-day search period for unposted Medical History and speeds up the process.</td>
</tr>
<tr>
<td>S</td>
<td>Discount split-billing</td>
<td>Applies pre-defined discounting on the patient to the co-owners account.</td>
</tr>
<tr>
<td>*</td>
<td>Aggressive</td>
<td>Marks the patient as aggressive and will display an alert.</td>
</tr>
</tbody>
</table>

Certificate
Each time a treatment with a Y action code is entered into Medical History AVImark allows you to record a certificate number.

- Type a number other than 0. Each time this specific treatment is entered into Medical History, AVImark will automatically increment to the next certificate number.

Rabies
This field displays the current rabies tag number.

- Type the patient’s current tag number.

Locator
With an account set up with ePetRecords®, AVImark provides the ability to allow access of secure, on-line medical records to other veterinarians and the pet owner.
Microchip
This field displays the microchip or tattoo number up to 15 characters. This number will print on the AVImark vaccination certificate.

- If appropriate, type the microchip number.

Code
If the patient is currently enrolled in an AVImark Health Plan, the plan name will be displayed. You are not allowed to type any information into this field. Once the plan is selected for the patient, AVImark will fill in this field.

Photos
AVImark allows you to link photo images (.jpg, .bmp, .tif or DICOM format) with the client, patient and medical history records.

**Copy photos from a camera**

- From the patient area, right-click and from the shortcut menu click **Photo**.
- In the AVImark Image Editor, open the **File** menu and click **Get Image**.
  - If your camera is not listed select File, Open from the menu and choose the appropriate drive where the camera is installed.
  - Locate the appropriate image.
  - Double-click the image name or click once and select **OK**.
- In the AVImark Image Editor, open the **File** menu and click **Save as**.
- With the correct file name in the **File name** field, click **Save**.
- Click **OK** to save the image.

**Copy photos into \PHOTOS\Client number\Patient name.**
Chapter 7: Patient Area

- In Hospital Setup, System tab, set the **in sub-directories** field to **By Client, then patient**.
- In the Attachments area in the lower right corner of the CID, select the **Photograph** box to display the AVImark Image Editor.
- On the AVImark Image Editor, open the **File** menu. Click **Open** to display the Open window.
- Using the **Look in** drop-down list, locate the drive and directory where the camera’s images are kept.
- Select the correct image and click **Open**.
- On the AVImark Image Editor, open the **File** menu. Click **Save as** to display the Save as window.
- Click **Ok** to save the image.

**Class (Discount)**
AVImark uses this name to automatically discount the charges that are entered for a specific patient. With a Class Discount code entered here, this will override any Class Discount set up on the client.

- If appropriate, enter a class discount code.

**Folder**
This value will be displayed in parentheses, just to the right of the patient’s name on the CID.

- Type the folder number.

**Reminded**
This is the date when a reminder is printed for this patient. AVImark will automatically fill this date in; however, you may also type a date if you print a reminder card for this patient only.

**Added**
This is the date the patient was added to your files. AVImark will automatically insert the current date. You may change this date by clicking on the drop down list to choose the appropriate date from the calendar. AVImark will ask you to confirm the change.

**Suspend until**
You may temporarily suspend the reminders for this patient.

- Using the drop down calendar, select the date to suspend reminders to.

**Allergy**
Entering an allergy for the patient will display a Patient Alert with the appropriate information when the patient is selected.

- Using the drop down menu, select appropriate allergies. To add allergies to this list from the CID select Work with, System Tables and add allergies to the Allergy Table.
- If the appropriate allergy is not listed simply type the allergy in the field.

**Deceased**
AVImark will fill this date in for you when the Patient is marked as deceased.

<table>
<thead>
<tr>
<th>To learn more about:</th>
<th>Search the Help for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add New Patients</td>
<td>Add Patient</td>
</tr>
<tr>
<td>Patient photos</td>
<td>Patient Photos</td>
</tr>
<tr>
<td>Image Editor</td>
<td>Image editor</td>
</tr>
<tr>
<td>Health plan</td>
<td>Discount plans; Health plans</td>
</tr>
</tbody>
</table>

Vaccination Reminder History
After creating the patient the Vaccination History window will be displayed. Only those reminders you have chosen to appear in this window will be displayed.

- From this window enter the dates of the patient’s last vaccinations.
- To not have this window automatically displayed, uncheck the option Show This Window When Patient Are Added.

### Print a Patient Chart

You may print a Patient Chart to include client, patient and a specified amount of Medical History as well as reminder information, diagnosis information, medical notes, and so on.

![Patient Chart image]

- From the patient area, right-click and from the shortcut menu click **Chart** to display the Patient Chart.
- In the **Print for** field, select your chart length preference by typing the numeric value and use the drop down list to select Days, Months, Visits, or Entire Chart.
- From the **View** field drop down list, select the preferred sort option.
- Select the chart options from the **Include** area you want printed on the chart.
- If appropriate, type a **Report Code** to only include treatments and items that have a specified Report Code.
- Click **Print** to print the chart or **Preview** to view the chart on screen.

### Display Patient ID Number

When a new patient is added AVImark assigns that pet and ID number but it is not displayed directly on the CID screen; however, AVImark does give you the ability to display this number.

- From the CID select the **Advanced Options** speed bar button.
- In the **search** field type **display** and select the option **Display Patient Record Number**.
• Change the Value to True and AVImark will display patient ID numbers on the CID screen to the right of the Patient area.

Work with the Reminders Folder

At the right side of the Patient Area, reminders which are appropriate for the patient will be displayed in a Reminders folder. Each reminder will be listed along with its due date. Any reminders that are displayed in red indicate they are past due, those due within the next 30 days will be displayed in blue, those reminders which are current will be displayed in black and those reminders that are patient specific will default to being displayed in green or the user defined color.

<table>
<thead>
<tr>
<th>EXAM</th>
<th>Annual Health Exam</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>BORDVC</td>
<td>Canine Bordetella Vaccine</td>
<td>06-20-08</td>
</tr>
<tr>
<td>00</td>
<td>Rabies 1 yr Canine Combo</td>
<td>06-20-08</td>
</tr>
</tbody>
</table>

Restore Default Reminders

AVImark lets you add all the reminder templates specified in your Treatment List to a particular animal. This has the effect of re-applying those reminders which are appropriate for this species.

• In the Reminder folder, right-click and from the shortcut menu click Defaults. This will prompt you to discard current reminders for the patient and add default reminders.

Post Reminder Treatment from the folder

AVImark allows you to post treatments which are listed in the reminder folder into Medical History. This will update the reminders and Medical History for this patient.

• In the Reminders folder, select the correct treatment. Right-click and from the shortcut menu click Post. You will need to click Yes to post the reminder to Medical History.

Postpone Reminders from the Reminders folder

You may postpone the reminder dates for any treatments within the Reminder folder.

• In the Reminders folder, right-click and from the shortcut menu click Postpone.
• Using the drop down list, specify how you wish to postpone the reminder by selecting At Age, In or an On date.
• Type the appropriate value for the postponed time.
• Using the drop down list, select, Days, Weeks, Months, or Years where appropriate.
• Click OK. You will be prompted whether to postpone each reminder from the Reminder folder.

Add a new reminder template for this patient
AVImark lets you specify the conditions under which you want to remind for any treatment and/or inventory item you select. You do this in what are called Reminder Templates, which are normally set up for each treatment and applied to all patients at once. In addition, AVImark allows you to add or change a reminder from the reminder folder. Adjusting the reminder from the folder now makes the reminder specific for this patient.

- In the Reminder folder, right-click and from the shortcut menu click **New** to display the Patient Reminder Template.
- Set up the template appropriate for this patient and click **Done**.

**Change a patient reminder template**

When a given reminder is appropriate for certain patients, but due to special circumstances you need to change the reminder template and how it applies to this particular patient.

- In the Reminder folder, right-click and from the shortcut menu click **Change** to display the Patient Reminder Template.
- Adjust the template appropriate for this patient and click **Done**.

*When you change the Due date, a Due date set by user checked box will appear to the right of the date indicating that AVImark’s calculation has been overridden. The date will display in green on the Reminder folder indicating it is a patient specific reminder. If you need to return to the original date, just uncheck the box.*

**Prevent reminder override**

When a reminder template has been modified for a particular patient, AVImark allows you to prevent any changes to the modification, even though the template’s normal specifications have changed in your Treatment List.
• In the Reminder folder, right-click and from the shortcut menu click **Change** to display the Patient Reminder Template.
• On the reminder template select the **Advanced Tab**.
• Uncheck the **Allow override from template** box and click **Done**.

### To learn more about:  
[Search the Help for:]  
Working with the Reminders Folder  
Reminders Tab

Set up a Patient Follow-up

The Follow-up listing is a list of patients who need to be called back after a short period of time. When a follow-up becomes past due, the Follow-up folder tab will be displayed in red.

![New Follow-up window](image)

• With the correct patient selected, select the Follow-up folder tab.
• Right-click and from the shortcut menu click **New** to display the Change Follow-up window.
• Using the **Subject** field, type the subject matter for the follow-up.
• Using the **Doctor** drop down list, select the **Doctor**.
• If appropriate, select the **Critical** box.
• Using the **Due Date** drop down calendar, select the **Due Date** or specify in how many days the follow-up becomes due.
• If appropriate, use the **Repeat every** fields and specify how often the follow-up should be repeated.
• Using the **Comments** section, specify any memos or notes and click **Done**.

![Follow-ups Tab](image)

### To learn more about:  
[Search the Help for:]  
Set up a patient follow-up  
Follow-ups Tab

Specify a Patient Estimate
You may specify one or more estimates for a patient by choosing one from the canned estimates as it is or modify it, and/or build estimates from scratch for the selected patient. AVImark also allows you to customize the name of the Estimate tab as well as additional areas that reference the Estimates such as the Work with menu and the Canned and Patient Specific Estimate windows. This can be done from the Option Maintenance area of Hospital Setup. Because of the extensive estimate handling capabilities, Estimates will be explained more in detail in “Error! Reference source not found.”.

Set up Ownership/Split-Billing

AVImark gives you the capability to divide charges entered for a patient among any number of clients. The Percent Ownership field in the Change Ownership window will display the existing owner's percentage of ownership of the patient or be blank for you to enter the new owner's percentage of ownership. In addition, the Ownership tab will allow the patient’s ownership history to be displayed. If a patient’s record has ever been moved from one client to another, using the move functions that are available, the previous owner(s) as well as the date that patient was moved will be recorded. All previous owner entries will be displayed in a gray color representing their ghosted ownership. This allows easy tracking of a patient’s owner history and the dates that correspond to the previous owners.

<table>
<thead>
<tr>
<th>Owner</th>
<th>Ownership Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kostial, Jeff</td>
<td>50%</td>
</tr>
<tr>
<td>Carter, Wynn</td>
<td>50%</td>
</tr>
<tr>
<td>Cunningham, Karen</td>
<td>100%</td>
</tr>
<tr>
<td>*** Confidential ***</td>
<td>100%</td>
</tr>
</tbody>
</table>

- With the correct patient displayed, select the Ownership folder tab.
- Right-click and from the shortcut menu click New to display the Change Ownership window.
- In the Client No field, type the client number for the client to which split billing is to be applied.

- Using the Percent Ownership field, type the ownership percentage as a whole number. AVImark will calculate the percentages of ownership and will warn you if the percentages entered do not equal one hundred percent.
Chapter 7: Patient Area

- If there is a time when you would like to hide a particular owner on the CID screen, this can now be done by using the Public checkbox. This option defaults to being checked in the New Owner window. Un-checking the Public option in the New/Change Ownership tab will prevent the owners full name from being listed. Owners that are not public will be displayed in the tab by the client account number and the ownership percentage amount. The clients name will be kept confidential by showing as asterisk in the ownership tab on the CID. Both current and previous owners can be marked public or not.

- If you would like to “de-activate” a previous owner select the Previous Owner box. This will display the previous owner grayed out within the Ownership Tab. Once an owner has been marked Previous Owner it is not possible to “reactivate” the same owner again from the Change Ownership window. To setup the owner again the client must be entered again with a new Start date to be associated with the patient as having part ownership.

- If appropriate, select Has Ultimate Authority.

- If applicable, type any notes appropriate for the entry. All the AVImark® notes feature options are available from this window.

- Click OK.

<table>
<thead>
<tr>
<th>To learn more about:</th>
<th>Search the Help for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ownership/Set-up Split Billing</td>
<td>Ownership Tab; Split billing</td>
</tr>
</tbody>
</table>

Work with the Schedule Folder

From the patient’s Schedule folder, you may add new appointments, review and make certain changes to the scheduling status of a patient. AVImark has extensive boarding and appointment handling functions described in detail in “Error! Reference source not found.” and “Error! Reference source not found.”.

Add, change or remove appointments and reservations

- With the correct patient displayed, select the Schedule folder tab.
- Right-click and from the shortcut menu click New to display the New Appointment window.
- On the New Appointment window, use the Date drop down calendar and select the date.
- In the Time field, use the UP and DOWN arrows to set the correct appointment time.
- Select the correct Doctor from the Doctor drop-down list.
- Enter any Notes, Treatments/Items and/or Problems associated with this appointment and click Done.
Check the Patient in

- From the Schedule folder tab of the correct patient, right-click and from the shortcut menu click Check-in to check the patient in.

- If the Whiteboard does not display, right-click on the Schedule folder to display the shortcut menu and click Whiteboard. For detailed information regarding the Whiteboard, refer to “Error! Reference source not found.”.
Add Patient Notes

AVImark allows you to create unlimited notes or memos about the patient. You may also import text files (files with an extension of .txt) and/or copy and paste note templates from the Note Glossary into any AVImark note window. For detailed information on adding, importing and creating note templates, refer to “Error! Reference source not found.”.

- In the Patient area, right-click and from the shortcut menu click Notes.

Delete a Patient

You may delete a patient including all Medical History related to the patient.

- From the patient area, right-click and from the shortcut menu click Remove.
- You will need to click Yes to confirm.

Undelete a Patient

AVImark allows you to retrieve Patient, Medical History and Accounting information that has been deleted from your files.

- From the patient area, right-click and from the shortcut menu click Undelete to display the Undelete Patients window.
- You will need to click Yes to confirm searching for deleted patients.
- Select the patient(s) you wish to undelete by highlighting the patient name and use the SPACEBAR to select (bold). You may also right-click and from the shortcut menu click Select All to undelete all patients listed.
- Select the patient information; Medical History, Reminders, Follow-ups, Split-billing, Appointments, and Boarding you would like to undelete using the same procedures for selecting patients.
- When all the appropriate information has been selected (bolded) click Undelete.

Move a Patient to another Owner

This feature allows you to move a patient and its Medical History to a different client file.

- From the patient area, right-click and from the shortcut menu click Move.
- You will need to click Yes to confirm the move. This will display the Client Selection window.
- Enter the new client information and click Continue to display the CID for the new client.
- Click Yes to confirm the move from one client to the other.

To learn more about: Search the Help for:
Add patient notes Add Patient notes
Undelete a patient Undelete; Undelete patients
Moving patients Moving patient; Moving

Access Patient Lab Information

By accessing the Patient Lab Information you can view test result history for a selected patient as well as export that data to Excel. This is a Ready-Only window and allows you to view the result history based on test and organized by date.

- From the Patient area right-click and from the shortcut menu click Patient Lab Information.
- Individual test name tabs will be created for each test type that exists for the patient.
• Test information data for the selected Test Type tab can be exported to Excel by selecting File, Create Excel from the menu area.

Print Patient ID Collar

This feature allows you to print a patient collar for pets which are boarded, hospitalized or checked-in by appointment. For this option to work you will need to print the labels to the Pet Detect CT-400, which can be purchased from PetDetect®.

• From the patient area, right-click and from the shortcut menu click Print Collar.
• Choose the collar size and the printer. Select what you would like to have printed on the collar.
• Click on Details to include specific client and patient information on the collar. To print the patients name in a large bold print on the collar check the Enlarge Name option.

View Patient Problem History

AVImark’s Problem History feature allows you to view open or closed problems for the specific patient. A problem can be opened directly in the Problem Histories window, from the Medical History or from the SOAP (Medical Condition) window.

• From the patient area, right-click and from the shortcut menu click Problems.
• Right-click and from the shortcut menu select the desired option.
• Open to display the Problem List window and choose a problem to add.
• New to add a problem to the history by entering the code of the problem.
• Change to change information about an open problem.
• Remove to remove a problem from the history.
• Close to close a problem once it is resolved.
• Use the Edit shortcut menu to undo or redo changes and to select entries.
• From the View shortcut menu option you can refresh the screen, customize columns, view an entry history, preview or hide text and group columns.
• View History will return you to the CID with the Medical History entry linked to the open problem automatically highlighted.
• Whogot allows you to view and/or print a list of all patients who have been diagnosed with this problem.
• Review the Document associated with the selected problem.
• Select Protocol to view and/or add diagnostic protocols for this problem.
• Uses the Notes option to view and/or add notes about the selected problem.

Print a Document for the Selected Patient

You may print any MS Word document from the selected patient.

• From the patient area, right-click and from the shortcut menu click Document to display the Print Document window.
In the Document field, right-click and from the shortcut menu click **Choose** to display the Open window.

Select the file name you wish to print and click **Open** to return to the Print Document window.

Use the **Copies** field to specify the number of copies to print.

Use the **Print to** drop down list and select the correct printer.

Click **Print** or select **Preview** and click **Print** to preview the document on screen.

**Enter a Patient Alert**

This feature allows you to have an alert message appear when you first select the patient that the alert has been set up for.

From the patient area, right-click and from the shortcut menu click **Alerts** to display the ATTENTION! window.
Add File Attachments
AVImark gives you the ability to attach multiple files to a patient such as; documents, images, spreadsheets, and so on.

- From the patient area, right-click and from the shortcut menu click File Attachments to display the Patient File Attachments for window.
- In the File Attachment window, right-click and from the shortcut menu click New to display the New Patient File Attachment window.
- In the Filename field, click to display the Open window.
- Select the file name you wish to attach and click Open to return to the New Patient File Attachment window.
- Click OK.
- Attach multiple files using the same procedures.

View as Gallery
AVImark allows you to view photos as a gallery when multiple photos are attached to the patient.

- From the Patient File Attachment window, open the View menu. Click View As Gallery.
Add Notes
Notes can be added to any file; however, Gallery view must not be selected.

- Select the file you wish to add notes to. Right-click and from the shortcut menu click Notes to display the File Attachment Notes window.
- Type the notes pertaining to the file and click Done.
Chapter 7: Patient Area

**Preview notes attached to the file**

- From the Patient File Attachment window, open the View menu. Click Preview Text to display the Columns window.
- Select the Show Preview Text option and select Notes.
- Click OK to return to the Patient File Attachment window.
- When finished click Done.

**Add Invoice Instructions**

You may enter Patient Instructions to be printed on the invoice.

- From the patient area, right-click and from the shortcut menu click Instructions to display the Invoice Instructions for window.
- Type the instructions pertaining to the patient and then click Done.

**View Patient Photo and Photo Album**

AVImark lets you display an album style listing of all photos attached to the patient.

- In the patient area, right-click and from the shortcut menu point to Photo.
- Click My Photo to view or work with the photo that has been linked with the patient or click Photo Album to display a tabloid of all photos linked with the patient.

**Print Patient Labels**

You may print patient ID labels for any or all patients belonging to a client.

- In the patient area, right-click and from the shortcut menu click Label to display the Print Patient ID Label window.
- Use the Copies field to indicate how many labels you wish to print.
- Using the Print to drop down list select the correct printer.
- Select for each patient if you wish to print a label for each of the client’s patients.
- Click Print.

**Define a Patient Work List**

AVImark lets you define a Work List of jobs that would typically be assigned to appropriate staff to perform depending upon their abilities. For example: Update medical records; feeding; blood samples; recording vital signs, and so on. This list of jobs is up to you and may be defined in your System Tables. The Work List window is a free floating window that works along side the CID. Also
if the Work List is left open and a patient is open on the CID, if the patient is on the Work List AVImark will automatically select the patient on the Work List.

Accessing the Work List
The Work Lists can be accessed by using one of two methods:

- From the CID menu area select Clients, Work Lists. You can then choose the list you want AVImark to display. The shortcut keys **Ctrl+Alt+F10** can also be used to open the lists.
- Or in the Patient area, right-click to display the shortcut menu, and point to Lists and click the appropriate Work List name.

Toggling Between Lists
Once a Work List is open you can easily toggle between the lists you have defined.

- In the Work List click on the Work List drop-down arrow and select the list you wish to display.
- Or in the list press **Shift+Tab** until the Work List field is highlighted. In this field simply type a few characters of the list name you want to display and AVImark will display the list and the associated entries.

Manually assign a patient to Work List
You may manually assign a patient to any number of Work Lists so that a staff member may view or print a list of patients on the list(s) that is their job to perform.

- In the Patient area, right-click to see the shortcut menu. Point to Lists and click the correct Work List name.

![Work List Window]

- From the Work List window, right-click and from the shortcut menu click **New** to include the patient on the list.

Automatically link a patient to a Work List
AVImark allows you to assign up to three Work Lists Codes to any treatment so that when you perform the treatment, the patient is automatically added to one or more Work Lists. For more information on assigning Work List codes, refer to “Error! Reference source not found.”

Enter/View Work List Notes

- With the correct patient highlighted in the Work List window, right-click and from the shortcut menu click **Notes** to display the Notes window.
• Enter the notes about the job as related to the patient and click Done.
• To view notes in the Work List window, open the View menu and click Preview Text.
• Click the Notes option and click in the Show Preview Text box.
• After clicking OK AVImark will display the notes directly on the screen.

Use the Work List
• In the Patient area, right-click to see the shortcut menu. Point to Lists and click the correct Work List.
• With the correct patient highlighted right-click and from the shortcut menu click Accept to display the CID for that patient. The Status for the selected patient will be set to In progress.
• After the work is completed, select the correct patient from the list.
• Right-click and from the shortcut menu click Remove to remove the patient from the Work List.
• You will need to click Yes to confirm.

Posting Work List Entries
After a patient has been accepted on the Work List and you have attached notes you might find it beneficial to post the entry to the patients Medical History. This will store the attached notes in Medical History which helps in keeping efficient notes.
• Open the appropriate Work List and select the correct patient.
• Right-click and from the shortcut menu click Post to remove the entry from the Work List and post the notes to the patients Medical History.

After closing the list and opening the patients file on the CID you will see the notes entry displayed in the pets Medical History.

Renew a patient on the Work List
When a patient has been accepted or removed from the Work List, the patient may be renewed/added back to the list.

If the patient has been accepted:
• Select the correct patient from the Work List.
• Right-click and from the shortcut menu click Renew. The Status for the selected patient will be set to New.

If the patient has been removed:
• From the Work List window, open the Work List menu and click Show ghost to display the removed patient.
• Select the correct patient from the Work List.
• Right-click and from the shortcut menu click Renew. The Status for the selected patient will be set to New.

Go to the selected patient
You may access any patient that is displayed on the Work List.
• Select the correct patient from the Work List.
• Right-click and from the shortcut menu click Open Patient to display the CID for that patient.

Transfer a patient to another list
You may transfer a patient from one Work List to another.
• With the correct patient selected in the Work List window, right-click to see the shortcut menu and point to Change.
• Click on the Work List drop-down arrow and select the Work List you wish to move the patient to.
Chapter 7: Patient Area

- After clicking **OK** AVImark will transfer the selected patient to the Work List you had selected.

**Additional Work List Options**
The Work List can be customized to fit your needs by utilizing the customizable features and many features have been added to give flexibility when working in a Work List.

- In the desired Work List you can customize the displayed columns by selecting **View, Columns** from the right-click menu. Use this option to display or remove columns on the list.
- To select multiple entries highlight an entry and press the **Shift** key to select consecutive entries or use the **Ctrl** key to select random entries. You can then **Remove, Accept, Post** or **Renew** those entries by selecting the desired option from the right-click menu.
- To open the selected patients account open the right-click menu and point to **Open Patient**.

**Add Patient to Work List at Check-In**
By utilizing an Advanced Option AVImark will allow you to add a patient to a Work List at the time they are checked in.

**Set up**
Before you set the Advanced Option you will need to open Work With, System Tables and locate the Work List table. Open the Change window of the appropriate Work List entry and make note of the code.

- From the CID select the **Hospital Advanced Options** speed bar icon.
- In the **Search** field type **work** and select the entry **Add Patient to Work List Code**.
- Once the entry is selected click **Change** under the **Values** tab.
- In the **Value** field type the code of the Work List you want to add the patient to at the time they are checked in.

Once the pet is checked in they will automatically be added to this Work List.

**Work Lists More Stuff**
AVImark gives you the ability to create Additional Data Fields that can be utilized in the Change Work List window.

**Setup**
The additional data fields must be defined in System Tables.

- From the CID menu area select **Work with, System Tables**.
- Under the Table area click on the **Additional Data Fields** table and click once on the **Additional Work List Fields** entry.
- To begin creating additional data fields right-click and select **More Stuff Fields** from the menu.
- Enter the desired fields and click **OK** to save them and then click **Done** to close the window.

To have a blank field for typing information you will want to use the type of Phrase when defining the data field.

**Using Additional Fields**
After the fields have been defined they will appear in the Change Work List window.

- From the CID, **Patient** area open the desired **Work List**
- In the Work List highlight an entry, right-click and select **Change** from the menu.
- The additional field will appear at the bottom of the Change window ready for you to enter the desired information.

By utilizing the Columns feature you can display the defined Additional Data Field as a column on the Work List.
Export/Import Patients

This feature allows you to export client, patient, medical history, and reminder data for existing clients and patients to either a removable media such as diskette, CD, zip cartridges or to an internet-based site, called the AVImark Data Safe.

With either method, your data may be encrypted so that it is unreadable except by the AVImark provided data import feature. Your information is also protected by a password that is provided to you at the time the data export takes place. Only another AVImark clinic will be able to import the information into their data base using the automatically generated User ID and password displayed immediately following the preparation of the file for export. When the importing clinic imports the file into their AVImark program they will have the option of importing the patient information to the currently selected client's file or to a new client file.

Export client and patient records

- In the Patient area, right-click to see the shortcut menu. Point to Export and click either Export patient(s) or GlobalVetLink®.

Import client and patient records

- In the Patient area, right-click and from the shortcut menu click Import patient(s) to display the AVImark Import Data window.
- Enter the User ID and Password that was provided during the export.
- Select the appropriate import Options.
- Select from what Source to import and click Continue.

Use an E-Travel Sheet

AVImark gives you the ability to create and use an electronic Travel Sheet for patients.

- In the patient area, right-click and from the shortcut menu click e-Travel sheet.
- To display all codes in addition to those with the F action code, select Show all entries.
- Using the Treatment, Inventory and Diagnosis tabs, select the desired codes to add to the selected box.
- Click Close to save the codes for the patient.
- Click Post to add the codes to the patient’s Medical History.
<table>
<thead>
<tr>
<th>To learn more about:</th>
<th>Search the Help for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export/Import patients</td>
<td>Data export</td>
</tr>
<tr>
<td>GlobalVetLink®</td>
<td>GlobalVet</td>
</tr>
<tr>
<td>E-Travel Sheet</td>
<td>E-Travel sheet</td>
</tr>
</tbody>
</table>